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CAUTION!
•   Remove power to unit before wiring 

input and output connections.
•   Follow instructions carefully to avoid 

personal injury.
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1. Description
• ProcessPro transmitters are available in two styles: panel mount and fi eld mount.  The panel mount is supplied with the necessary 

hardware to install the transmitter.  This manual includes complete panel mounting instructions.
• Field mounting requires one of two separate mounting kits.  The 3-8052 integral kit joins sensor and instrument together into a 

single package.  The 3-8050 Universal kit enables the transmitter to be installed virtually anywhere.
• Detailed instructions for integral mounting or other fi eld installation options are included with the 3-8052 Integral kit or the 3-8050 

Universal kit.

General
Compatible Sensors:
• Signet 2450 pressure sensors
Enclosure: NEMA 4X/IP65 front
Materials:
• Case:   PBT
• Panel case gasket:  Neoprene
• Window:   Polyurethane-coated polycarbonate
• Keypad: Silicone rubber
Weight:   Approx. 325g (12 oz.)

Display:
• Alphanumeric 2 x 16 LCD
• Sealed 4-button keypad
• Display update rate:  1 second
• Contrast:  User selected, 5 levels

Environmental 
• Operating temperature: -10 to 70°C (14 to 158°F) 
• Storage temperature: -15 to 80°C (5 to 176°F)
• Relative humidity: 0 to 95%, non-condensing
• Maximum altitude: 2000 m (6562 ft)

Electrical
Power supply: 12-24 VDC ±10% regulated, 250 mA max current
Sensor power (provided by 8250): 5 VDC ±1% @ 25ºC, regulated 
 2-wire system: 1.5 mA maximum current
 4-wire system:  20 mA maximum current

Current output (2 loops provided):
• 4 to 20 mA, isolated, fully adjustable and reversible
• Max loop impedance:  50Ω max. @ 12 V
        325Ω max. @ 18 V
        600Ω max. @ 24 V
• Update rate:  300 ms
• Output accuracy:  ±0.03 mA

Relay outputs:
* 2 sets mechanical SPDT contacts standard with all units.
• Software supports 2 additional relays via optional external 

relay module
• Maximum voltage rating:
 5 A @ 30 VDC, or 5 A @ 250 VAC, resistive load
• Programmable for High or Low setpoint or for Window range, 

with adjustable hysteresis
• May be disabled if not used
• Time delay: programmable from 0 to 6400 s

Standards and Approvals:
• CE, UL listed
• Immunity: EN50082-2
• Emissions: EN50081-1
• Safety: EN61010
• Manufactured under ISO 9001 and ISO 14001

2. Specifi cations
Dimensions

7. Editing procedure
8. Calibrate menu
9. Options menu
10. Troubleshooting

LVL1 10.000 ft
LVL2 10.000 ft

Relay 1 Relay 2

ENTER

Signet Level
Transmitter

*3-8250.090-3*

3-8250.090-3  Rev. F 3/06  English 
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Terminals 7-12: Relay Outputs
2 sets mechanical SPDT contacts programmable as:

• High or Low setpoint with adjustable hysteresis
• "Window" limits with adjustable hysteresis
• Time delay up to 6400 seconds. 
• May be disabled (Off) if not used.
• Auxiliary power (terminals 1-2)  MUST be connected for 

relay operation

Terminals 3 and 4: Loop 1 Power and system power
Terminals 5-6: Loop 2 power
12-24 VDC ±10% 
Max. loop impedance: 50  Ω max. @ 12 V

    325 Ω max. @ 18 V
    600 Ω max. @ 24 V

Terminals 1 and 2:  AUXILIARY power
Required for all systems that include any one 
of  the following features:
• Any relay operation
• All dual sensor systems

quick-clips

gasket
panel

terminals
mounting
bracket

latch
Output -

Output +

System Pwr

Loop -

System Pwr

Loop +
2

1

4

3

Sensr Gnd

(SHIELD)

Sensr IN

(RED)

Sensr V+

(BLACK)

7

6

5

Panel Mount
Installation Detail

 3. Panel Installation 
 1. The panel mount transmitter is designed for installation 

using a 1/4 DIN Punch.  For manual panel cutout, an 
adhesive template is provided as an installation guide.  
The cutout must be 92 mm x 92 mm.  Recommended 
clearance on all sides between instruments is 25 mm/1 in.

 2. Slide the instrument into the cutout from the front of the 
panel.

 3. Slide the mounting bracket over back of instrument until 
quick-clips snap into latches on side of instrument.

 4. To remove, secure instrument temporarily with tape from 
front or grip from rear of instrument.  DO NOT RELEASE.

  Press quick-clips outward and remove.

2

1

Caution:  Fully open terminal jaws 
before removing wire to avoid 
damage to connector.

4. Electrical Connections
Wiring Procedure
 1. Remove 0.5 - 0.625 in. (13-16 mm) of insulation from wire end.
 2. Press the orange terminal lever downward with a small screwdriver to open 

terminal jaws.
 3. Insert wire into terminal until it bottoms out. 
 4. Release orange terminal lever to secure wire in place.  Gently pull on each 

wire to ensure a good connection.
Wiring Removal Procedure
 1. Press the orange terminal lever downward with a small screwdriver to open 

terminal jaws.
 2. When fully open, remove wire from terminal.

Terminals 13-18: Digital (S3L) input/output
Two sensors and one External Relay Module 
connect here.

Loop 2 -

Loop 2 +

System Power
Loop 1 -

System Power
Loop 1 +

AUX
Power -

AUX
Power +

Relay 2
(NO)

Relay 2
(COM)

Relay 2
(NC)

Relay 1
(NO)

Relay 1
(COM)

Relay 1
(NC)

12
11
10
9
8
7

Gnd

I/O

V+

Gnd

I/O

V+

18
17
16
15
14
13

6
5
4
3
2
1
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4.2 Serial Data Connections
• The Input/Output terminals on the 8250 carry S3L™ serial data from two 2450 

sensors and from the external relay module.
• The two sets of serial input terminals are parallel.   It does not matter which 

terminals are used, or the order of the sensors connected.
• You MUST reset sensor confi guration (see Calibrate menu) for all new 

systems and after connecting any new sensor to the I/O terminals.
• Use the SWITCH SENSOR ID function (Calibrate menu) to reverse  LEVEL 1 and 

LEVEL 2 if necessary.
• Do not route sensor or output cables in conduit containing AC power wiring.  

Electrical noise may interfere with sensor signal.
• Routing cable in grounded metal conduit will help prevent electrical noise and 

mechanical damage.
• Seal cable entry points to prevent moisture damage.
• Only one wire should be inserted into a terminal.  Splice double wires outside the terminal. 
• The TOTAL cable length from all I/O devices to the transmitter must not exceed 122 m (400 ft.).
• For best performance, ground the sensor SHIELD wire to a local earth ground at a point near the sensor.
• Consult the sensor manual for additional wiring information.

4.1 System Power/Loop  Connections
Stand-alone application, no current loop used 

Transmitter

Terminals

Power

Supply

12-24 VDC

Connection to a PLC with built-in power supply

Internal 

PLC Connection

Connection to a PLC/Recorder, separate supply

Example:  Two transmitters connected to PLC/Recorder with separate power supply

-

+

PLC or Recorder

Loop 2 -

Loop 2 +

System Power Loop 1 -

System Power Loop 1 +

AUX Power -

AUX Power +

6

5

4

3

2

1

Transmitter

Terminals

Loop 2 -

Loop 2 +

System Power Loop 1 -

System Power Loop 1 +

AUX Power -

AUX Power +

6

5

4

3

2

1

6

5

4

3

2

1

Transmitter

Terminals

Loop 2 -

Loop 2 +

System Power Loop 1 -

System Power Loop 1 +

AUX Power -

AUX Power +

Loop 2 -

Loop 2 +

System Power Loop 1 -

System Power Loop 1 +

AUX Power -

AUX Power +

6

5

4

3

2

1

6

5

4

3

2

1

Loop 2 -

Loop 2 +

System Power Loop 1 -

System Power Loop 1 +

AUX Power -

AUX Power +

Power

Supply

12-24 VDC

-

+

PLC or Recorder

Channel 3

4-20 mA in

Channel 4

4-20 mA in

-

+

-

+
Transmitter 1

Terminals

Transmitter 2

Terminals

PLC Terminals 

Channel 1

4-20 mA

+
-

Power
Supply

12-24 VDC

Channel 2

4-20 mA
+
-

-
+

Channel 2

4-20 mA

+
-

Channel 1

4-20 mA
-
+

Channel 1

4-20 mA in

Channel 2

4-20 mA in

+

-

+

-

Power

Supply

12-24 VDC

-

+

NC

NC

*

*
*

**
* Note:

AUXILIARY power is required:
for all dual-sensor systems
to operate the relays.

Signet 2450
Pressure Sensor

8250-3
I/O Terminals

Sensor Gnd
Sensor IN
Sensor V+
Sensor Gnd
Sensor IN
Sensor V+

18

17

16

15

14

13

8059 External 
Relay Module

Technical Tip:
"Check Sensor" indicates that the 8250 does not 
recognize a sensor on the channel.  Run the "Reset 
Sensor Confi guration" function in the Calibrate menu 
to "introduce" new sensor(s) to the 8250.

Wire two sensors in series for 
maximum cable distance.

8250-3 I/O Terminals J-box

AB

 A + B² 400 ft. (122 m)

15

14

13

8250-3 I/O Terminals

A + B² 400 ft. (122 m)

AB
18

17

16

15

14

13
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Zero reference point (Z):
Defi nition:
 The point in the vessel where you want the 8250 to display 

zero (0 ft., 0 gal. etc).
• If Z is located below the fl uid surface, the 8250 will display 

a positive level measurement.
• If Z is located above the fl uid surface, the 8250 will display 

a negative level measurement. 

Sensor Location point (SLoc):
Defi nition:
 The point on the level sensor where the measurement is 

taken.
• Pressure sensors measure from the centerline of the 

diaphragm.

Offset (O):
Defi nition:
 The distance from the zero reference point (Z) to the sensor 

location point (Sloc).
• Enter a positive value in the Calibrate menu if the sensor is 

located above Z (zero reference point).
• Enter a negative value in the Calibrate menu if the sensor 

is located below Z (zero reference point).
• Enter 0 in the Calibrate menu if the sensor is located at Z 

(zero reference point).

Level (L):
Defi nition:

• The distance from Z (zero reference point)  to surface of 
fl uid (displayed as "Level"  by transmitter. L > 0

O(ffset) > 0

Z(ero)

SLoc

L > 0

O(ffset) < 0
Z(ero)

SLoc

L<0

SLoc

O(ffset) < 0

Z(ero)

2450 Pressure Sensor Location and Offset

Z

Z

For horizontal cylinders only, 
the zero reference point MUST 
be the lowest point in the 
vessel.

For most vessels, the zero 
reference point may be 
designated as any height 
in the vessel.

5. System Confi guration

The 8250 Level Transmitter must be programmed using the following system confi guration procedure.

1. Determine where you want the level measurement to start.  This is the Zero reference point (Z).
 Review the diagrams for your sensor type to help select the best option.
2. Determine where you will mount the sensor.  This is SLoc.
 Consult the Sensor manual for information regarding the best location for the sensor.
3. Measure the distance between Z and SLoc.  This is O(ffset).
4. Enter the Offset into the Calibrate menu.
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r

h

Length

Volume calculations

Vertical cylinder:  V = π • d2 • h/4

where  d = diameter of cylinder
  h = height of fl uid

Rectangular vessel: V = w • l • h

 where  w = width
   l = length

Horizontal cylinder: V = A • L

 where  A = area of segment
  L = Length of vessel

Custom vessel:
The 8250 performs linear interpolation between adjacent points.

Custom point #10 3000 gal.

Custom point #1 0 gal.

Custom point #2 45 gal.

Custom point #3 118 gal.

Custom point #4 160 gal.

Custom point #5 250 gal.

Custom point #9 1300 gal.

Custom point #6 380 gal.

Custom point #7 700 gal.

Custom point #8 1000 gal.

5.1 Level and Volume conversion in custom shaped vessels
If you select Custom Shape in the Options menu, you can defi ne 
from 2 to 10 Custom Points to establish the relationship of level to 
volume in the vessel.

• Select Manual level Measurement mode to edit both level and 
volume data (dry confi guration).

• Select Automatic level Measurement mode to accept the 
sensor measurement of the Level, while you assign a 
volumetric value to each custom point (wet confi guration).

• Enter from 3 to 10 custom points to link level and volume 
values.

• The fi rst custom point must be the lowest fl uid level in the 
vessel.

• Each successive point must be greater than the preceding 
point.

• The last point must be equal to or greater than the highest 
fl uid level in the vessel.

• A custom point should be located at all transition points in 
the vessel shape (for example, at custom point #9, where the 
shape changes from a cylinder to a cone).

• The more complex sections should be defi ned with more 
points.  Notice that the conical section of the illustration has 
been defi ned by custom points 1 through 9.

• Simpler sections require fewer defi ning points.  Note that the 
cylinder requires only custom points 9 and 10.

Level, volume and mass calculations performed by the 8250 
include:

Pressure to level conversion:
 Level = P ÷ (SG • D(water))
where P = Pressure

 SG = Specifi c Gravity of fl uid
 D(water)  =  Density of water

With pressure in psi: Level (meters) = (0.703069 • P / SG)
with pressure in bar: Level (meters) = 1.019715 • P / SG)

Mass conversion
 m = D(water) • SG • V

where m  = mass of fl uid
  D(water)   =  Density of water = 1000 kg/m3

  SG  =  Specifi c Gravity of fl uid
  V =  Volume of fl uid (m3)
   
   m (kg) = 1000 • SG • V

A

5.2 Reference
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5.3 Relay Operation
Relay outputs can be used as switches that respond when the 
process variables move above or below setpoints, or when the 
process variables move outside of a window.
• The relays may be turned Off if not in use.
• Response can be delayed up to 6400 s ( see Calibrate menu).

Low:
Relay is energized when process variable is less than the setpoint.  
The relay relaxes when the process variable moves above the 
setpoint plus the hysteresis value.

High:
Relay is energized when process variable is greater than the 
setpoint.  The relay relaxes when the process variable moves 
below the setpoint plus the hysteresis value.

Window
Relay is energized when the process variable moves above or 
below a fi xed window of values.  The relay relaxes when the 
process variable moves inside the window by more than the 
hysteresis value.

Note:
Relays will operate in reverse if miswired.  Observe relay logic 
appropriate to the application.

6. VIEW menu

• During normal operation, the ProcessPro displays the VIEW menu.
• To select a display, press the UP or DOWN arrow keys.  The display selections scroll in a continuous loop. 
• Changing the display selection does not interrupt system operations.
• No keycode is necessary to change display selection.
• Output settings cannot be edited from the VIEW menu.
• When using the CALIBRATE or OPTIONS menus, the ProcessPro will return to the VIEW menu if no key 

is pressed for 10 minutes.

Displays  Level 1 and Level 2 values simultaneously when "Level" is  selected 
in the Options menu.
 
Displays Volume 1 and Volume 2 values simultaneously when "Volume" is  
selected in the Options menu.

Displays Level and Volume values simultaneously for Channel 1 or Channel 2 
when "Both" is selected in the Options menu.

View Menu
Display Description

These displays are temporary.  The permanent display will return after ten minutes.

 LVL2:  20.000 gal
VOL2:  400.00  gal

The following displays are permanent.   They will remain as selected until you change them.

LVL1 10.000 ft
LVL2 10.000 ft

Relay 1 Relay 2

ENTER

Signet Level
Transmitter

Loop 1 19.00 mA
Loop 2 20.00 mA

 Relay A: On
Relay B: Off

No Relay Module
 Detected

 Last Cal: 
 03-17-02 

Displays Loop 1 and Loop 2 (4-20 mA) outputs

Displays the status of Relays A and B. 
Appears only when external relay module is detected.

Displayed if the relay module is not detected at Sensor Confi guration (see 
calibrate menu).

Displays the date for scheduled maintenance or date of last calibration.

Hysteresis

Time

Low Setpoint

Process

Hysteresis

Time

High Setpoint

Process

High Limit
Hysteresis

Hysteresis

Window

Time

Low Limit

Process

Relay energized
Relay relaxed

LVL1:  10.000 ft 
LVL2:  20.000 ft 

VOL1:  300.00 gal
VOL2:  400.00  gal 

LVL1:  10.000 ft
VOL1:  300.00  gal
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Notes on Steps 5 and 6:
•  All output functions remain active during editing.
•  Only the fl ashing element can be edited.
•  RIGHT ARROW key advances the fl ashing element in a continuous loop.
•  Edited value is effective immediately after pressing ENTER key.
•  If no key is pressed for 10 minutes unit will restore the last saved value and return to step 3.
•  Step 6 (pressing ENTER key) always returns you to Step 3.
•  Repeat steps 3-6 until all editing is completed.

Notes on Step 2:
If no key is pressed for 5 minutes while display is showing "Enter 
Key Code", the display will return to the VIEW menu.

Notes on Steps 3 and 4:
•  Refer to pages 8-10 for complete listing of menu items and their use.
•  From the Step 3 display, pressing the UP and DOWN keys simultaneously will 
return the display to the VIEW menu.
•  If no key is pressed for 10 minutes, display will also return to the VIEW menu.

7. ProcessPro Editing Procedure:

Step 1.  Press and hold ENTER key:
  •  2 seconds to select the CALIBRATE menu
  •  5 seconds to select the OPTIONS menu.
Step 2.   The Key Code is UP-UP-UP-DOWN keys in sequence.
  •  After entering the Key Code, the display will show the fi rst item in the selected menu.
Step 3.  Scroll menu with UP or DOWN arrow keys.
Step 4.  Press RIGHT ARROW key to select menu item to be edited.
  •  The fi rst display element will begin fl ashing.
Step 5.  Press UP or DOWN keys to edit the fl ashing element.
  • RIGHT ARROW key advances the fl ashing element.
Step 6.  Press ENTER key to save the new setting and return to Step 3.

OPTIONS

CALIBRATE

VIEW

2s 5s

Press &
hold for 
access:

ENTER

Step 5

Step 6

Notes on Step 1:
•  The View Menu is normally displayed.
•  The CALIBRATE and OPTIONS menus require a KEY CODE.

Step 4

First item in CALI-
BRATE menu

Step 3

Step 3:  Finished Editing?
Press the UP and DOWN keys simultaneously after 
saving the last setting to return to normal operation.

Press the UP and DOWN keys simultaneously 
while any element is fl ashing.  This will recall the 
last saved value of the item being edited and 
return you to Step 3.

Step 5: Made an Error?

CALIBRATE: ----
Enter Key Code

CALIBRATE: *---
Enter Key Code

CALIBRATE: **--
Enter Key Code

CALIBRATE: ***-
Enter Key Code

   ft  >
  LVL Units:

Relay 1 Setpnt:
 +10.000 ft 

Relay 1 Setpnt:
 +00.000 ft 

ENTER

Relay 1 Setpnt:
   +00.000 ft  

Relay 1 Setpnt:
   +09.000 ft  

Relay 1 Setpnt:
Saving

Relay 1 Setpnt:
   +9.0000 ft   >

   ft  >
  LVL Units:

  +10.000 ft   >
Relay 1 Setpnt:
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Display
(Factory settings shown) Description

Select the units of measure:  ft, in, m,cm.

Yes: Level will be displayed as a percentage of the full scale.
No: Level will be displayed as engineering units.

If "Show LVL in %" is YES, enter the full scale value.  The units are the same as LVL Units

Enter the distance from sensor location to the Zero reference point in the vessel.
Enter + if the sensor is located above the Zero reference point.
Enter - if the sensor is located below the Zero reference point. 

Select the units of measure for Volume:  gal, ft3, in3, m3, kg, lb, or lit (liters)

Yes: Volume will be displayed as a percentage of the full scale.
No: Volume will be displayed as engineering units.

If "Show VOL in %" is YES, enter the full scale value. The units are the same as VOL Units

Enter the specifi c gravity of the fl uid.  Factory setting is 1 (water)
This setting is required if the level measurement is made by a pressure sensor
(Signet 2450), or if volume units are selected ( kg or lb ).

Single-point calibration for Level1.   (See Technical Tip below.)

 

Yes: Reset Level to original factory calibration. ("Set LVL1" entry is erased.)
No: Return to menu, do not reset Level.

   Re se t  LV L 1

 to  Fa ct o ry  Ca l:       >

8. Calibrate Menu

Settings will repeat for Level #2 and Volume #2.

TECHNICAL TIP

If you see this message:

"Too Much Error-Check Sensor" displayed during "Set Level"

The most likely cause: 

A new sensor has been connected to the 8250 but
"Reset Sensor Confi guration" has not been implemented.

     Reset  Se nsor

      Confi guration:    >

IMPORTANT TECHNICAL TIP.  DO THIS FIRST!
Before continuing with calibration, press the UP key two times, then press the RIGHT key to run the RESET  SENSOR 
CONFIGURATION FUNCTION.  This procedure introduces the sensor to the 8250 and enables many of the calibration functions.

Use this function during initial startup of a new system, and whenever a new sensor is added 
to the system.  It enables the 8250 to scan the sensor input terminals and determine the type 
and specifi c serial numbers of the sensors connected to the sensor input.

    LVL 1   Un its :   

      ft         >

     Show  LV L 1  in %:

      No         >

     LVL  11 00  % :   

   + 0 . 0 0 0 0   ft   > 

    Sen sor 1  Of fse t:

   + 0 . 0 0 0 0  ft    >

    VOL 1  Un its :

     g al         >

  S ho w  VO L  1  in % :

      No         >

   V OL  1    10 0 % :    

   + 0 . 0 0 0 0  g a l   > 

  Sp ec  Gr avity :  

    1 . 0 0 0 0       >

    Se t  LV L 1 : 

                >
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Select the source for the 4-20 mA Loop:   LVL1, LVL2,r VOL1 or VOL2.

Select the minimum and maximum values for the 4-20 mA Current loop output.  

Select the mode of operation for Relay Output:  Low, High, or Window.
The relay may be disabled (Off) if not in use.  

Select the source for Relay:   LVL1, LVL2, VOL 1 or VOL2.

If Relay is in Low or High mode, the relay will be activated when the level or volume reaches 
this value.

If Relay is in Window  mode, the relay will be activated when the level or volume is less than 
or greater than the range.  You must enter the low limit into the fi rst fi eld, and the high limit 
into the second fi eld.

Relay will be deactivated at Setpoint ± Hysteresis.
The Hysteresis value is in Level units or % of full scale.  

Set up to 6400 seconds delay time for relay response.
Relay will be activated only if the source value exceeds the setpoint for this time period.

Reverses the identifi cation of Sensor inputs: SENSOR 1 becomes identifi ed as SENSOR 2, 
SENSOR 2 becomes identifi ed as SENSOR 1.
Use this function to make adjustments according to the requirements of your system

Use this function during initial startup of a new system, and whenever a new device is added 
to the system.  It enables the 8250 to scan the sensor input terminals and determine the type 
and specifi c serial numbers of the sensors connected to the sensor input.

Use this “note pad” to record important dates, such as annual recertifi cation or scheduled 
maintenance.

8. Calibrate Menu (continued)
Display

(Factory settings shown) Description

Relay settings will repeat for Relay #2 and for External relays A and B.
A and B Relays require the optional External Relay Module (model number 3-8059)

Relay settings below will not appear if the Relay mode is OFF

Settings willrepeat for Loop 2

TECHNICAL TIP

If you see this message:

"Check Sensor" displayed in normal operation.

The most likely cause: 

A new sensor has been connected to the 8250 but
"Reset Sensor Confi guration" has not been implemented.

 Loop 1 Source:

 LVL1 >

 Loop 1 Rng:  ft

+0.0000  →  +10.000 >

 Relay 1 Mode:

 Off >

 

 Relay 1 Source:

 LVL >

 Relay 1 Setpnt:

 +0.0000 ft >

 Relay 1 Rng:  ft

+0.0000   →  +10.000 >

 Relay 1 Hys:

 0.0000 ft >

 Relay 1 Delay:

 0.0 secs >

 Switch Sensor ID

 (CAUTION!) >

 Reset Sensor

 Confi guration: >

 Last Cal:  

 03-17-02 >
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Select the shape of the vessel where Sensor is located:
Vert Cylinder, Horiz Cylinder, Rectangular or Custom

If Vert Cylinder or Horiz Cylinder is selected:
Set the diameter of the cylinder
The unit of measure is set by "LVL Units" in Calibrate menu.

If Horizontal Cylinder or Rectangular shape is selected:
Set the length of the vessel. The unit of measure is set by "LVL Units" in Calibrate menu.

If Rectangular shape is selected:
Set the width of the vessel.  The unit of measure is set by "LVL Units" in Calibrate menu.

If Custom shape is selected, enter the number of manual calibration points to be 
entered.  Minimum is 3 points, maximum is 10 points. 

If Custom shape is selected:  select Manual or Automatic level measurement.
Manual allows you to Edit both the Level measurement and the Volume measurement.
Automatic allows you to Edit only the Volume measurement (While displaying the Level 
measurement)

Set the Volume (and Level if manual measurement is selected) at each custom point in 
your vessel. 

Adjust the LCD contrast for best viewing.  A setting of 1 is lower contrast, 5 is higher.  
In general, select lower contrast if the display is in warmer ambient surroundings.  
      
    
Select Level, Volume or Both.
This setting will determine the permanent display when the unit is in View mode.

Off provides near-instantaneous response to measurement changes.
Low (4 s averaging)  Medium (8 s averaging) or High (32 s averaging) will stabilize the 
system if your process experiences frequent fl uctuations or surface turbulence.                   
                                                                                          

Set the decimal to the best resolution for your application.  The display will automatically 
scale up to this restriction.  Select *****., ****.*, ***.**  or **.***    

    
Adjust the minimum and maximum current output. The display value represents the 
precise current output. Adjustment limits:
   •  The 4.00 mA output can be adjusted from 3.80 mA minimum to 5.00 mA maximum
   •  The 20.00 mA output can be adjusted from 19.00 mA minimum to 21.00 mA maximum              
   •  Use these adjustments to match the system output to any external device.    
  

Press UP and DOWN keys to manually order any output current value from 3.6 mA to 
21.00 mA to test the output loop.    
    
   
Press UP and DOWN keys to manually toggle Relay #1 Off and On. 

 Contrast:  
 3 >

 Display Option:  
 Level >
  
 Chan 1 Average:  
 Off >
 
   Chan 1 Decimal:
 ***.** >

 Loop 1 Adjust:  
  4.00 mA > 
 Loop 1 Adjust:  
 20.00 mA >

 Test Loop 1:  
  >
  
 Test Relay 1  
  >

Relay settings will repeat for Relay #2 and for external Relays A and B.

 VOL1 Shape:
 Vert Cylinder >

 VOL1 Diameter:
 0.0000 ft >

 
 VOL1 Length:
  0.0000 ft >

 VOL1 Width:
 0.0000 ft >

    Number of Custom 
    Points: 10  >

  LVL Measurement:
 Manual >

 P01: -0.0000 ft
  V:   -0.0000 gal >

9. Options Menu
Display

(Factory settings shown) Description

The following entries are used by the 8250 to convert the level into volumetric and mass measurements.  The accuracy of the entries 
will determine the accuracy of the volumetric and mass calculation.  Refer to section 5 for additional  information.
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Time delay cannot be greater than 6400 s.

Specifi c gravity value set to 0.0000

Custom Shape requires from 3 to10 
custom points.

A custom point has been entered that is not 
greater than the previous point.
(Custom points must be in ascending 
order.)

Number of custom points increased without 
setting new values so all custom points are 
not sequential.

Sensor-related problem during different 
operational modes:
1. Wiring problem:
 • AUXILIARY POWER is not 

connected
 • The sensor is not connected properly
 • The sensor wiring is loose
2. The sensor has not been confi gured 

("CHK SENSOR" and "Too Much Error")
3. The sensor is defective

• External Relay Module wiring is loose
• Relay module has been disconnected
•   Relay module has been replaced
• Relay module is defective

"Value must be 6400 or less"

"Value must be more than zero"

"Must have more than 1 point"
"Must have 10 or less points"

"Must be > than previous point"

"CustomTable Error"

"CHK SENSOR"
appears in VIEW mode

"Too Much Error
Check Sensor" appears during 
"SET LVL1" in Calibrate menu

"0 SENR(S)
FOUND:  SAVE ?" appears during  
"Reset  Sensor Confi guration" in 
Calibrate menu

"No Relay Module Found"

Display Condition Suggested SolutionsPossible Causes

10. Troubleshooting

Set time delay to a 6400 s or less.

Set Specifi c gravity to a value greater than 0.

Set number of custom shape points to a value 
from 3 to 10.

Reset the custom point to a value greater than 
the preceding point.

Review all custom points and reset values so 
each point is greater than the preceding point.

1. Check all wiring, especially AUX POWER

2. "RESET SENSOR CONFIGURATION"  in 
CALIBRATE  menu.

3. Replace the sensor, then RESET SENSOR 
CONFIGURATION.

1. Check wiring
2. RESET SENSOR CONFIGURATION
3. Replace External Relay Module.
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Ordering Information
Mfr. Part No.  Code   Description
3-8250-3  159 000 768  Dual Channel Level Transmitter, Field Mount
3-8250-3P  159 000 769  Dual Channel Level Transmitter, Panel Mount
3-8059-2  159 000 770  External Two-Relay Module
3-8059-2AC  159 000 771  External Two-Relay Module w/Power Supply
    
Accessories
Mfr. Part No.  Code   Description
3-8050   159 000 184  Universal mounting kit
3-8050.395  159 000 186  Splashproof rear cover
3-8052   159 000 188  3/4” Integral mounting kit
3-8050.396  159 000 617  RC Filter Kit (for relay use), 2 per kit
3-0000.596  159 000 641  Heavy Duty Wall Mount Bracket
3-9000.392  159 000 368  Liquid-tight connector kit, 3 sets, 1/2 in. NPT5
3-9000.392-1  159 000 839  Liquid-tight connector kit, 1 set, 1/2 in. NPT5
3-9000.392-2  159 000 841  Liquid-tight connector kit, 1 set, PG 13.5
7300-7524  159 000 687  7.5W 24V Power Supply 
7300-1524  159 000 688  15W 24V  Power Supply 
7300-3024  159 000 689  30W 24V Power Supply 
7300-5024  159 000 690  50W 24V  Power Supply 
7300-1024  159 000 691  100W 24V  Power Supply 


